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SAZETAK

U radu je opisana modna fotografija te njezin razvoj od samog pocetka u 18.
stolje¢u do danas. Na razvoj modne fotografije utjecala su razna povijesna
dogadanja, a svoj utjecaj dali su i modni fotografi, kako tijekom povijesti, tako i
danas. U radu su opisane vrste modne fotografije koje postoje danas, a s
obzirom da se modna fotografija dosta razvila u umjetni¢kom smijeru,
spomenuto je i $to ne ulazi u modnu fotografiju jer je ponekad to tesko
prepoznati. PobliZze je objasnjena ulicna modna fotografija, razlike u odnosu na
studijsku modnu fotografiju te njene prednosti i nedostaci u odnosu na studijsku
modnu fotografiju. Spominje se i finalno digitalno uredivanje fotografija te su
dani neki osnovni primjeri na koje nacCine se mogu poboljSati fotografije
digitalnim uredivanjem, a da se fotografije ne uniste te da i dalje ostanu
naizgled prirodne. Tijekom pisanja rada napravljeno je kratko istraZivanje o
tome koliko su ljudi u nasoj okolini upoznati sa modnom fotografijom, te da li ju
smatraju vaznom u danasnjem svijetu. Rezultati su promatrani s obzirom na

spol, dob, obrazovanije, te drustveni i poslovni status ispitanika.
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ABSTRACT

This article describes fashion photography and its development from the
beginning in the 18th century to the present. There have been various historical
events influencing the development of fashion photography, and influence also
has been made by fashion photographers both in history and today. This article
describes the types of fashion photography that exist today, and also describes
what is not considered fashion photography. The street fashion photography is
explained more closely, the differences compared to the studio fashion
photography and its advantages and disadvantages compared to the studio
fashion photography. Lastly, digital editing of photographs is also mentioned
and are given some basic examples of how photographs can be digitally
improved without being destroyed and remaining apparently natural. During the
writing work, a brief survey of how much people in our environment are familiar
with fashion photography and whether they consider it important in today's
world. The results were observed in terms of gender, age, education, and social

and business status of the respondents.
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1.UvOoD

Pojam modna fotografija opisuje vrstu likovne fotografije primarno posvecene
promociji modnih predmeta; odjecCe, obuce, nakita, kozmetike i ostalih proizvoda
dizajniranih od strane raznih modnih kuca diljem svijeta. U posljednjih nekoliko
godina, modna fotografija je postala vodeéi medij suvremene vizualne kulture.
Njezin status se razvio od modne podrske do kreiranja ikona i ideja. Modna
fotografija ima odredeni utjecaj na svim podrucjima komunikacije te se smatra
oblikom umjetnosti u svakom smislu. Modne fotografije 21. stoljeca usko su
povezane sa suvremenom umjetnoscu, te ne sluze promociji odredenih
proizvoda, ve¢ branda koji stoji iza tih proizvoda. Modna fotografija, ne samo da
odrazava popularne stavove, teZnje i ukuse, ve¢ odrazava i stavove Zena o
samima sebi, o0 svom spolu i seksualnosti. Takoder, modna fotografija je ovisna
i 0 medijima, u poCetku kako bi se zadovoljile potrebe Zenskih Casopisa

poput ,Vogue® i ,Harper's Bazaar®, a danas imaju svjetski utjecaj kao proSirenja
Casopisa poput ,Elle®, ,Cosmopolitan®, ,Vanity Fair®, W*, ,Grazia“i

drugih. Modna fotografija tezi ka tome da bude vjerodostojan pecat

ideala ljepote odredenog doba, kao i pokazatelj politiCke i socijalne klime. [2]



2.TEORIJSKI DIO

2.1. Povijest modne fotografije
2.1.1. Pocetak modne fotografije

PreteCe modne fotografije seZzu u davno 18. stoljece, kada su slike moderne
odjece tiskane u Casopisima te su €esto ru¢no bojane. (Slika 1 i Slika 2) Pariz je
u to vrijeme bio centar produkcije takvih Casopisa koji su se u velikoj mjeri

izvozili u Englesku. [1]

Slika 1. (lijevo) llustracija iz ,Lady's" Casopisa, Sije€anj 1814., jutarnja i ve€ernja haljina
http://www.finearts.cmu.ac.th/e_learn/fashion_photography.pdf
Slika 2. (desno) Najnovija moda za travanj 1829., vecernja haljina

http://www.finearts.cmu.ac.th/e_learn/fashion_photography.pdf

Fotografska tehnika otkrivena je 1830-ih, ubrzo nakon ¢ega se razvila modna
fotografija. Ranija fotografska tehnika, dagerotipija, nije se mogla koristiti za
masovno tiskanje. Kasnija tehnika omogudila je stvaranje Carte de Visite koja je
napravljena za pojedince te je prikazivala osobnosti poznatih kazaliSnih i
glazbenih dvorana tog doba. U prvom desetljeéu 20. stolje¢a, napretkom

tonskog ispisa, modne fotografije su doSle do izrazaja u ¢asopisima. [1]


http://www.finearts.cmu.ac.th/e_learn/fashion_photography.pdf
http://www.finearts.cmu.ac.th/e_learn/fashion_photography.pdf

2.1.2. Utjecaji i razvoj modne fotografije kroz povijest

Najranije modne fotografije nastale su 1860-ih, kako bi dokumentirale kreacije
vodecih pariskih modnih kuca. Ideja zaposljavanja profesionalnih modela
smatrala se nepristojnom, tako da su modni fotografi ovisili o drustveno slavnim
osobama, kao Sto su u to vrijeme bile Gertrude Vanderbilt Whitney i

Sarah Bernhardt. Cak i kasnije kada su zaposleni modeli, umjetnici su ih radije
skicirali nego fotografirali bojeci se da ¢e fotografije odati javnosti tajne modnih
dizajnera i njihovog rada. Modne fotografije koriStene su sve do izuma
polutonskog ispisa, Sto je omogucilo reprodukciju modnih fotografija u
Casopisima i priblizilo modnu fotografiju Siroj publici. Dva najvaznija modna
Casopisa, oba osnovana u Americi, bili su ,Harper's Bazaar® (Harper &
Brothers,1867.) i ,Vogue® (Arthur Turnure,1892.). [2]

Slika 3. (lijevo) Prva naslovnica asopisa ,Harper's Bazaar®, 1867. godine

http://www.harpersbazaar.com/culture/features/a9517/bazaar-140-0107/
Slika 4. (desno) Prva naslovnica ¢asopisa ,Vogue®, 1892. godine
http://tmagazine.blogs.nytimes.com/2014/08/21/vogue-magazine-

list-10-most-groundbreaking-covers-in-the-history-of-vogue/


http://www.harpersbazaar.com/culture/features/a9517/bazaar-140-0107/
http://tmagazine.blogs.nytimes.com/2014/08/21/vogue-magazine-list-10-most-groundbreaking-covers-in-the-history-of-vogue/
http://tmagazine.blogs.nytimes.com/2014/08/21/vogue-magazine-list-10-most-groundbreaking-covers-in-the-history-of-vogue/

2.1.2.1. Kultura i moda u Parizu (1880.-1930.)

S pojavom velikih umjetnickih trendova poput impresionizma,
postimpresionizma, secesije, fauvizma i kubizma, Pariz je bio srediSte za sve
ozbiljne umjetnike koji su se bavili slikarstvom i kiparstvom. Berlin je bio jos
jedan vazan centar avangardne umjetnosti i dizajna, zahvaljujuci utjecaju
njemackog ekspresionizma, kao i utjecaju galerije ,Sturm®, kasnije ,Bauhaus
Design School®. Takoder, veliki utjecaj imale su aktivnosti fotografa kao Sto su
John Heartfield, Raoul Hausmann, Hannah Hoch, Heinrich Hoffmann

i Laszlo Moholy-Nagy. [2]

Isto je bilo i u modnom svijetu. Svi su glavni trendovi potekli iz Pariza i Berlina,
te su ti francuski i njemacki modni trendovi bili prikazivani u ,Harper's Bazaaru® i
,vogueu“. S obzirom da su sve glavhe modne kuce i dizajneri bili smjesteni u
Parizu, tamo se i razvila modna fotografija. Zapravo, prvo ozbiljno fotografsko
snimanje napravio je 1911. godine u Parizu fotograf Edward Steichen, snimajudi
seriju haljina modnog dizajnera Paula Poireta kako bi prikazao njihovu fizi¢ku
kvalitetu kao i atraktivan izgled. Objavljene u €asopisu ,Art et Decoration®,
Steichenove fotografije bile su videne kao prve moderne modne fotografije

ikada objavljene. [2]

Sto su Steichen i ,Vogue* dali suvremenoj fotografiji bili su preteéa skoro svih
modnih oglasavanja koja su dolazila godinama poslije. Steichen je formirao svoj
vlastiti jedinstveni vizualni rjeénik tijekom 1920-ih i 1930-ih godina, oslobadajudi
klasi€ne renesansne slike kubizma i futurizma kako bi stvorio nesto sto je bilo
svjeze i uzbudljivo. Njegova uporaba modela, rasvjete i eksperimentalnih
studijskih tehnika bila je potpuno revolucionarna i dugogodi$nji njegovi
suvremenici nisu imali drugog izbora nego pratiti njegov put. Steichen je
promijenio lice modne fotografije, a njegove inovacije i dalje se koriste do
danas. [3]

Ostali francuski ¢asopisi koji su zaposljavali modne fotografe tijekom predratnih
godina bili su ,La Mode Practique®“i ,La Gazette du Bon Ton“. Modernu
francusku modnu fotografiju promovirali su i braca Seeberger (Jules, Louis i

Henri), koja su pocela snimati portrete visokog francuskog drustva oko 1910.



godine. Kako su se takvi portreti prekrasnih Zena, odjevenih u najnoviju modu
na konjskim utrkama i odmaralistima, poceli pojavljivati u novinama i
Casopisima, dizajneri kao to su ,Chanel“, ,Hermes* i ,Madeleine Vionnet*

poslali su svoje modne modele na fotografiranje kod brace Seeberger. [2]

lako ju je teSko pogodio veliki rat, Francuska je tijekom 1920-ih i 1930-ih
zadrzala svoju poziciju kao srediSte umjetnosti i mode, zahvaljujuci rodenju
nadrealizma 1924. godine, kao i usponu modnih dizajnera kao sto su ,Chanel”,
,Balenciaga®, ,Schiaparelli“i ,Lanvin“, od kojih su svi postali poznati po svojim
osebujnim stilovima. Kao rezultat toga, Pariz je nastavio priviaciti vrhunske
umjetnike s fotografskim aparatima, uklju¢ujuéi Horst P. Horst, Man Ray, Cecil
Beaton, George Hoyningen Huene, Erwin Blumenfeld, Brassai i Andre Kertesz,

kao i dizajnerskog genija Alexeya Brodovitcha. [2]
2.1.2.2. Modna fotografija u Americi (1900.-1930.)

Aktivnosti u Parizu nisu sprijecile ni napredovanje ameri¢ke modne fotografije.
Uzgoj bogatstva zemlje, mo¢ Casopisa ,Harper's Bazaar” i ,Vogue®, kao i svoju
tradiciju fotografske umjetnosti, primjerice djelom Alfred Stieglitz, a kasnije Paul
Strand, Charles Sheeler, Dorothea Lange i Walker Evans, sve su kombinirali
kako bi New York bio inovativan. Prvi ugledni ameri¢ki modni fotograf bio je
Baron Adolph de Meyer poznat po svojim elegantnim portretima poznatih osoba
kao Sto su Mary Pickford, John Barrymore, Lillian Gish, Ruth St. Denis, britanski
kralj George V i Kraljica Mary, 1913. godine postao je prvi sluzbeni modni
fotograf za ameriCki Casopis ,Vogue“. De Meyer je bio prvi koji je upoznao svoje
modne fotografije s osje¢ajem raspolozenja, kupajuci ih u Cistoj atmosferi i
svjetlucajucem svjetlu. To poboljSanje otvorilo je nacin na koji modna fotografija
izaziva Sirok raspon osjecaja kod gledatelja i tako napusta tradicionalnu
konvenciju koristenja modnih fotografija samo za ilustraciju. Tijekom ranog
dijela 20. stoljeca, jos jedan znacajan Cimbenik rasta americke modne
industrije, a time i americke modne fotografije, odnosio se na uspon industrije
odjece, i istovremeni razvoj neovisnog ameri¢kog stila, sasvim nepovezanog s
pariSkom modom. U stvari, americko modno trziSte prebaceno je iz parisSkih

moda na individualiziranu odjecCu koja se prodaje i promovira kroz asopise kao



sto su ,Women's Wear Daily®, ,Harper's Bazaar® i ,Ladies Home Journal“ (1903.
postao je prvi americki Casopis koji je dosegao 1 milijun pretplatnika). Godine
1924. ucinci mekog fokusa Adolpha de Meyera nadvladali su Cisti geometrijski
stil fotografskog modernizma Steichena koji je zamijenio jednostavne, ali
elegantne pozadine za de Meyerove postavke za rokoko. Poput glatkih linija,
geometrijskih oblika i pojednostavljenih oblika Art Deco, vrlo je utjecajni
dizajnerski pokret razvijen u Americi Steichenovim fotografijama pokazao da su
ameri¢ki modni fotografi namjeravali voditi Europu, a ne slijediti je. Cinjenica da
je Amerika bila zemlja europskih iseljenika, oslobodena od tradicionalnih i
staromodnih vrijednosti njihovih domovina, bila je dodatna prednost. Tako je
Steichen uspio prikazati modernu Zenu u suvremenom stilu odjec¢e koja je
odrazavala njenu slobodu iz korzeta, situacija koju je Horst P Horst kasnije
prikazao u svojoj fotografiji za ,Vogue®, pod naslovom "The Mainbocher Corset"
(1939). (Slika 5) [2]

Slika 5. Fotograf Horst P Horst za ¢asopis ,Vogue®,
fotografija "The Mainbocher Corset" (1939.)
http://onlyoldphotography.tumblr.com/post/24889656899/

horst-p-horst-mainbocher-corset-1939-in


http://onlyoldphotography.tumblr.com/post/24889656899/horst-p-horst-mainbocher-corset-1939-in
http://onlyoldphotography.tumblr.com/post/24889656899/horst-p-horst-mainbocher-corset-1939-in

Drugi vazan razvoj napravio je Carmel Snow, urednik ¢asopisa ,Harper's
Bazaar” koji je angazirao madarskog sportskog fotografa Martina Munkacsia
kako bi snimio neke fotografije za reklamu kupacih kostima, na otvorenoj
vjetrovitoj plazi. Dok je model Lucile Brokaw potr¢ala prema fotografskom
aparatu, Munkacsi ju je snimio, zamucene i prigusene kose, te je u tom trenutku
razbio konvenciju da se modne fotografije mogu snimiti samo u kontroliranom
studijskom okruzenju (Slika 6.). Munkacsin spontani realizam revolucionarizirao
je estetiku modne fotografije i otvorio put drugima. Takoder je vazan i izum
Kodachromea koji je 1935. godine uveo Eastman Kodak. Jedna od prvih
umjetnica koja je koristila boju u modnoj fotografiji bila je Louise DahlWolfe ,
najpoznatija po svojim vanjskim fotografijama za ,Harper's Bazaar”. Ona je
takoder bila jedna od prvih koja je koristila prirodno svjetlo i egzoti¢ne lokacije

za svoje fotografije. [2]

Slika 6. Martin Munkacsi - fotografija modela Lucile Brokaw za €asopis ,Harper's Bazaar*
https://www.artnet.com/auctions/artists/martin-munkacsi/

lucile-brokaw-piping-rock-beach-long-island-2


https://www.artnet.com/auctions/artists/martin-munkacsi/lucile-brokaw-piping-rock-beach-long-island-2
https://www.artnet.com/auctions/artists/martin-munkacsi/lucile-brokaw-piping-rock-beach-long-island-2

2.1.2.3. Drugi svjetski rat i 1950-e

Pojava rata izazvala je brojne europske slikare, kipare i fotografe da se presele
u Ameriku. Trend je zapoceo tijekom tridesetih godina proslog stoljeca i ubrzao
je od vremena Hitlerova uspona na vlast u Njemackoj 1933. godine. Tako je,
primjerice, dizajner i fotograf Alexey Brodovitch emigrirao iz Pariza u New York
1930. godine, Martin Munkacsi je to ucinio 1934. godine, George Hoyningen
Huene 1935. godine, a Erwin Blumenfeld 1941. godine. Moda u Americi tijekom
drugog svjetskog rata bila je depresivno poslovanje. Ne samo da je bio ozbiljan
nedostatak modnih materijala, dizajnera i modela, ve¢ su ljudi izgubili interes za
odjecu s obzirom na toliko tragedije. Moda se smatrala neozbiljnim i
nepotrebnim oblikom samozadovoljstva. Kako bi se povezali s njihovim
Citateljima, modni Casopisi profilirali su ulogu Zene u ratu, promicali modu kao
nesto moralno, zamijenili drustvene stupce s ratnim izvjeS¢ima, te se bauvili
krojenom, ali obicnom uniformnom odjecom. Studijska fotografija sa svojim
skupim rasvjetnim sustavima i slozenim postavkama nestala je gotovo u
cijelosti. Mnogi fotografi (Lee Miller u Parizu, Cecil Beaton u Londonu, Louise
DahlWolfe u New Yorku) usvojili su takav izravni stil. Do kraja rata, globalni
centar modne fotografije pomaknuo se iz Pariza u New York, gdje je
suparnistvo izmedu Casopisa ,Harper's Bazaar® i ,Vogue“ bilo u punom
zamahu. Najznacaijniji fotografi bili su Martin Munkacsi, Louise DahlWolfe, Irving
Penn, Richard Avedon, a svi su imali zna¢ajan doprinos modnoj fotografiji, iako
¢e Penn i Avedon dominirati tim podru¢jem u godinama koje dolaze. Poput
mnogih velikih suvremenih umjetnika, imali su sposobnost ponovnog stvaranja
skoro svakog desetljeca. Avedonove fotografije bile su obiljeZzene svojim
Sarmom, beznacajnoSc¢u i bezgranicnom vitalnos¢u. Takoder je imao jedinstveni
dar za inventivno riskantno i mastovito eksperimentiranje, te je uvijek pronalazio
lica koja najbolje opisuju izgled trenutka, kao $to su Dorian Leigh, Suzy Parker,
Twiggy, Jean Shrimpton, Brooke Shields i Nastassja Kinski. Nasuprot tome,
Pennova fotografija bila je sve o ljepoti i oblicima koji su se savrSeno kombinirali
u njegovoj kasnijoj seriji fotografija. Bio je prvi koji je koristio svijetlosive i bijele
pozadine, a njegove studijske fotografije bile su estetske i pedantne. Ako se

Avedonov rad moze opisati kao neposredan, onda je Penn monumentalan.



Osim modnog rada, obojica su proizveli izvanrednu umjetnost portreta, na
primjer, Pennov besmrtni portret Pabla Picassa ili Avedonov portret modela koji

nosi Dior haljinu okruzenu afri¢kim slonovima. [2]

Drugi veliki poslijeratni talent bio je britanski fotograf Norman Parkinson, koji se
1946. pridruzio internacionalnome Casopisu ,Vogue“ te je po€eo raditi za
americki ,Vogue“ 1949. godine. Parkinsonov akcijski realisti¢ki stil i veca

osobnost Zivota pomogle su preobraziti konvencionalnu modnu fotografiju. [2]

Opcenito, moze se reci da je sredinom pedesetih godina nova fluidna i
energicna estetika nastala kako bi zamijenila statiCniji predratni pristup. U
nekom smislu to je bilo samo odraz sve veéeg povjerenja koje su pokazali i
poslovni ljudi i potrosaci. Uz ponovnu zainteresiranost za odjec¢u, potaknute
stiliziranom slikom i odjec¢om filmskih zvijezda, americke Zene pocele su zeljeti

vise mode i modnih ¢asopisa. [2]
2.1.2.4. Modna fotografija 1960-ih

Dok je pedesetih godina proslog stoljeca uveden svjez, avanturistic¢ki duh u
umjetnost modne fotografije, 1960-e svjedoéile su potpunoj promjeni. Citav novi
svijet mode otvoren je kao posljedica kulturnih revolucija 1960-ih. Novi oblici
pop glazbe, pop umjetnost, vise slobodnog vremena, liberalniji stav prema
seksu i, naravno, iznenadni generacijski jaz, sve to u kombinaciji pomoglo je da
moda postane intenzivno relevantna za mlade. Rasprostranjen nagon mladih da
budu Trendy ili Cool potaknuo je potraznju za novim stilovima, oblicima,
materijalima i bojama. Drugi vazni utjecaji na stavove o modi, a time i modnoj
fotografiji, bili su Vijethamski rat, NASA-ini prostorni program, pokret
oslobodenja Zena i pitanje rase. lako kultura mladih ne dominira u potpunosti,
60-ih godina je moda redefinirala zahtjeve mladih ljudi. Ta rastuca potraznja za
modom, povezana s promjenjivim drustvenim i moralnim vrijednostima, imala je
veliki utjecaj na modnu fotografiju. Najbolji mladi fotografi kao $to su David
Bailey, Terence Donovan i Brian Duffy uzivali su u statusu popularnosti, a
Bailey je postao gotovo poznat kao i slavne osobe koje je fotografirao. Modeli,
poput Jean Shrimpton (Bailey-eva muza), Twiggy, Lauren Hutton i Veruschka,

postali su op¢e poznata imena. Ako je 1960-ih modna fotografija imala



jedinstvenu estetiku, bila je to novost. Casopisi su trebali nove i uzbudljive
fotografije da bi se natjecali. David Bailey bio je naglasen, izravan i neumoljivo
usredotoCen, Terence Donovan je vodila u upotrebi ostrih i grubih urbanih
sredina, Yasuhiro Wakabayashi, poznatiji kao Hiro, upotrebljavao je neobi¢nu
rasvjetu, kreativne suprotnosti i jedinstven osjecaj za boju kako bi stvorio
monumentalan, nadrealni stil; Bob Richardson stavio je seks, drogu i rock 'n' roll
u svoje fotografije, kao i Art Kane u 26. godini, umjetnicki direktor za ¢asopis
,Seventeen®, dok je Diane Arbus proizvela neke od najpotresnijih djecjih modnih

fotografija ikada objavljenih. [2]
2.1.2.5. Modna fotografija 1970-ih

Tijekom sedamdesetih godina, egzoticni, hipi stilovi 60-ih zamijenili su se
prakti¢nijom odje¢om. Jeans je postao svakodnevni odjevni predmet te je
potraznja za gotovom (ready to wear) odje¢om porasla. Moda se Sirila od
mladih do svih dobnih skupina, a ovaj novoosnovani konzumerizam doveo je
modu u vise milijardi dolara vrijednu industriju ojacanu sjajnim reklamnim
kampanjama i televizijskim reklamama. Francuski ,Vogue* tada je kreativno
vodio u modnoj fotografiji zahvaljujuci fotografskim umjetnicima kao $to su
Helmut Newton i Guy Bourdin. Newton je bio najpoznatiji za subverzivne i
erotske fotografije koje na neki nacin odrzavaju ironi¢an ton, dok je Bourdin bio
poznat po svojim visoko umjetnickim, Sarenim, ponekad nadrealnim
fotografijama. Deborah Turbeville bila je prva koja je koristila neugodne modele
prekomjerne tezine. Svi troje pomogli su preobraziti konvencionalnu, dobro
osvijetlienu modnu fotografiju u nesto puno nervoznije i bezboznicki. Modni
modeli i dalje su bili popularni u 1970-ima. 1975. godine Margaux Hemingway
potpisala je prvi milijunski ugovor kao lice ,Fabergéovog“ parfema ,Babe“, a
Lauren Hutton pojavila se na naslovnici ¢asopisa ,Vogue® ¢ak 25 puta. Crni
modeli takoder su bili popularni u to vrijeme, poput Donyale Luna, Naomi Sims i
Beverly Johnson, prvi afroameriCki model koji se pojavio na naslovnici
americkog ,Voguea“ 1974. godine. Ostali vrhunski modeli 1970-ih godina bili su
Cybill Shepherd , Patti Hansen, Penelope Tree, Grace Jones i Jerry Hall. [2]
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2.1.2.6. Modna fotografija 1980-ih

Dok su neke od najkreativnijih modnih fotografija 1980-ih nastavili snimati stari
fotografi poput Richarda Avedona, primjerice, njegova pripovjedna reklamna
kampanja ,The Diors", ili njegovo snimanje gole Nastassje Kinski sa zmijom,
pojavili su se i novi fotografi koji su takoder bili u centru pozornosti kao §to su
Herb Ritts, najpoznatiji po svojoj fotografiji "Stephanie, Cindy, Christy, Tatjana,
Naomi, Hollywood 1989." koja se pojavila u ,Rolling Stone“ ¢asopisu, Bruce
Weber koji je predstavio novi pogled na muzevnost kroz svoje fotografije za
L2Armani“i ,Calvin Klein“, kao i Robert Mapplethorpe s njegovim homo eroti¢nim
fotografijama, i Gian Paolo Barbieri, zabiljeZzen za svoj rad za modne dizajnere
SLArmani®, \Versace®, ,Dolce & Gabbana®, ,Pomellato” i ,Giuseppe Zanotti“. U
isto vrijeme, Zenska je neovisnost naglasena u razliitim okruzenjima, od strane

fotografa Denisa Piela i Berta Sterna. [2]

Kontroverze, uvijek prakticni alat kojim se moze potaknuti oglaSavanje, podigle
su glavu kao rezultat ,Benettonove“ modne kampanje, koju je snimio Oliviero
Toscani. Fotografije su ukljuCivale jedan od pacijenata koji umire od AIDS-a
ispred tugujucih rodaka, dok su drugi ukljucivali reference na rasizam, rat, vjeru
i smrtnu kaznu. Vodec¢i supermodeli modne fotografije 80-ih uklju€uju, izmedu
ostalog, Gia Marie Carangi, Ines de la Fressange, Cheryl Tiegs, Christie
Brinkley, Paulina Porizkova, Brooke Shields, Heather Locklear, Carol Alt i Elle
Macpherson. Tijekom ovog desetlje¢a supermodeli su prestali biti vidljivi kao

pojedinci i poceli su se smatrati slikama, ba$ kao i filmske zvijezde. [2]
2.1.2.7. Modna fotografija 1990-ih

Moda tijekom 90-ih godina okrenula se gotovo maniristicki, potroSaci su zagrlili
grube grunge stilove, kao i tetovaze i piercinge. Kasnije u desetlje¢u doslo je do
ozivljavanja odredenih stilova kasnih 60-ih i ranih 70-ih, iako su devedesete
godine zadrzale i svoj vlastiti stil. Dugogodisnji umjetnici kao Sto su Irving Penn i
Helmut Newton i dalje su dominirali tim podrucjem, dok je Ellen von Unwerth
uvela gledatelje u svoj jedinstveni brand erotske Zenstvenosti. Pored toga,
Peter Lindberg, koji je poznat po svojim crno-bijelim fotografijama, postigao je

slavu s naslovnicom ,Voguea“ iz sijeCnja 1990. godine, u kojoj su sudjelovale
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Christy Turlington, Cindy Crawford, Naomi Campbell, Linda Evangelista i
Tatjana Patitz. U meduvremenu je njegov mladi sljedbenik Steven Meisel
hvaljen zbog svojih fotografija Madonne u njezinoj knjizi ,Seks* iz 1992. godine i
fotografija za €asopis ,Vanity Fair“. Peruanski modni fotograf Mario Testino
takoder je primio pozornost za svoje fotografije pokojne Lady Di, princeze

Walesa za ,Vanity Fair iz 1997. godine. [2]

Klju€ni fotografski trend nazvan heroin chic, mozda reflektirajuci rodnu
ambivalentnost doba, bio je koristenje blijedih izgladnjelih modela, primjerice za

"Obsession" Calvin Kleina Mario Sorrenti snimio je Kate Moss. [2]

Devedesete godine vidjele su najveci uspon modne snage modela, kao $to su
utjelovljenje fotografskih superzvijezda ranije spomenutih poput Naomi
Campbell, Linda Evangelista, Christy Turlington, Claudia Schiffer i Tatjana
Patitz. Devedesete su takoder svjedocile rastucoj upotrebi slavnih osoba u
modnim fotografijama, kao $to je primjerice Julia Roberts, koja je postala lice

modne kuée ,Lancome®. [2]
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2.1.3. Poznati modni fotografi kroz povijest

2.1.3.1. Baron Adolph de Meyer (1868.-1946.)

Prvi modni fotograf vjerojatno je bio Baron Adolph de Meyer, koji je 1913.
godine unajmljen od strane ,Conde Nasta“ da bi snimio eksperimentalne
fotografije za Casopis ,Vogue®. Njegova glavna karakteristika bila je prekrasna
uporaba pozadinskog osvjetljenja i le¢a mekog fokusa. Rane slikovnice bile su
u osnovi fotografije drustva aristokrata, glumica i modela u odjeci. Ukupni kljuc
ove fotografije je svijetlosiva, jedina tamna podrucja su oko lica, ruku i krila
(Slika 7.). [1]

Slika 7. Fotografija koju je snimio Baron Adolph de Meyer

https://www.pinterest.com/pin/17170042300393558/
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2.1.3.2. Edward Jean Steichen (1879.-1973.)

S Alfredom Stieglitzom, Edward Jean Steichen utemeljio je fotografske galerije
u New Yorku. Prvo je snimao modne modele 1911. za Casopis "Art et
Decoration", a tijekom dvadesetih godina radio je s ,Conde Nastom®. Ova je
fotografija napravljena za americki ,Vogue“ 1932. godine i prikazuje Normu

Shearer, odjevenu u ,Chanel® haljinu (Slika 8). [1]

" :
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Slika 8. Edward Jean Steichen - Norma Shearer u ,Chanel* haljini

http://theredlist.com/wiki-2-24-525-526-652-view-1930s-2-profile-norma-shearer.html
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2.1.3.3. George Hoyningen-Huene (1900.-1968.)

George Hoyningen-Huene bio je jo$ jedan od aristokratskih praktiCara rane
modne fotografije, a vecinu svojih najnezaboravnijih djela ucinio je izmedu
sredine dvadesetih i kraja drugog svjetskog rata. Roden je u Sankt Peterburgu,
ali se preselio u Pariz 1920. godine, gdje je najprije napravio modnu ilustraciju,
a zatim fotografiju. Godine 1935. preselio se u New York i radio uglavhom za
Casopis ,Harper's Bazaar®. Njegova najpoznatija fotografija bila je reklama za
kupadi kostim. Fotografija pokazuje precizan stav prema detaljima i rasporedu.
Modeli su smjesteni vrlo pazljivo, uz pozornost na ucinak svjetla i sjene. Scena
se €ini snimana na otvorenom, ali poblize gledajuci, moze se vidjeti da je, kao i
vecina modnih fotografija tada, snimljena u studiju. Prividno more je podrucje
svijetlo sive, sa hebom i slabo obojenim oblacima iznad njega. Vrlo realistiCan
ucinak dnevne svjetlosti postize jakim usmjerenim svjetlom, smjestenim na
gornju lijevu stranu. Enigmatsku kvalitetu povec¢ava €injenica da se modeli
izoliraju od publike, tako da se ne mogu vidjeti njihova lica, Sto potice znatiZelju

o tome kamo to oni gledaju i $to je to tako zanimljivo u daljini (Slika 9). [1]

p .
6

Slika 9. George Hoyningen-Huene — reklama za kupaci kostim

http://www.photography-now.com/exhibition/75291
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2.1.3.4. Cecil Beaton (1904.-1980.)

Zanimljiv razvoj tijekom 1930-ih bio je promjena Beatonovog stava prema
romantizmu i uzivanju u ranijem radu. Realnost su urednici preuzeli kao nesto
novo. Rezultat ove promjene smjera bio je doprinos u raskidu ugovora s
Casopisom ,Vogue® 1938. godine. U narednim godinama snimio je mnoge ratne

fotografije. [1]

Beaton je prvobitno angaziran od strane Ministarstva za informiranje i dobio je
zadatak snimanja ispred kuée. Tijekom tog zadatka uhvatio je jedan od
najdugotrajnijih trenutaka britanske patnje tijekom rata, onaj trogodisnje
.Blitzove“ Zrtve Eileen Dunne koja se oporavlja u bolnici, drzeci plidani
medvjedi¢ (Slika 10.). Kad je fotografija objavljena, Amerika se jo$ nije sluzbeno
pridruzila ratu, a Beatonove fotografije pomogle su gurati ameri¢ku publiku da

vrSi pritisak na njihovu vladu da pomaze Britaniji u trenutku potrebe. [1]

Slika 10. Cecil Beaton - trogodi$nja ,Blitzova“ Zrtva Eileen Dunne

http://time.com/3878665/cecil-beaton-portrait-of-eileen-dunne-1940-london-blitz/
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2.1.3.5. Richard Avedon (1923.-2004.)

Richard Avedon bio je ameri¢ki modni fotograf i fotograf portreta. Bio je vodeca
figura u svijetu fotografije od 1945. godine. ,Dovima sa slonovima“ (Slika 11)
jedna je od njegovih najslavnijih fotografija. To je prvi puta da je netko snimio
modela obucenog u visoku modu zajedno sa slonovima, $to je fotografiji dalo
odredenu Sok vrijednost. Avedonov modernizam imao je sveobuhvatan utjecaj

na fotografiju, a doSlo je i do odbacivanja ranijeg, klasi¢nog stila. [1]

Slika 11. Richard Avedon — ,Dovima sa slonovima®“

https://rebeccaprowler.wordpress.com/2008/09/22/photo-

review-dovima-with-elephants-by-richard-avedon/
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2.1.3.6. Helmut Newton (1920.-2004.)

Helmut Newton dobio je niz nagrada. Godine 1989. francuski ga je ministar
kulture nazvao Chevalier des Arts et des Lettres, a 1992. godine nagraden je
Grosses Bundesverdienstkreuz od strane Savezne Republike Njemacke, te mu
je ,Life” Casopis 1999. godine dao Life Legend Award nagradu za Zivotno djelo
u fotografiji Casopisa. Newtonovi su proveli zime u Los Angelesu tijekom
posljednijih 25 godina. Zivjeli su ostatak godine u Monte Carlu. Newton je donio
1000 radova rodnom gradu u listopadu 2003. godine, berlinskom muzeju koji je
predstavio njegov rad. Fotografije Helmuta Newtona, uglavhom postavljene u
skupim hotelima ili na ulicama europskih glavnih gradova, prikazuju visoku,
Zenu dugih nogu, Cesto androgenu. Svaka fotografija ima neku akciju ili situaciju
koja poziva gledatelje da zami$ljaju Sto se dogadalo prije ili poslije. Slika 12
prikazuje Zenu koja zamisljeno stoji u muskom odijelu. Postoji osjecaj seksualne
dvosmislenosti, sa zalizanom kosom prema iza, podsjec¢a na Berlin 1920-ih.
Ova kao i vecéina njegovih fotografija je crno-bijela, a film je zrnast, dajuci

lagano ostar, neometan efekt (Slika 12.). [1]

Slika 12. Fotografija koju je snimio Helmut Newton

http://www.dutchnews.nl/features/2016/06/the-work-of-helmut-newton-set-to-take-over-

amsterdams-foam-gallery/
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2.1.3.7. Annie Leibovitz (b. 1949.)

Annie Leibovitz je poznata americka fotografkinja portreta. Rodena je 2.
listopada 1949. godine u Waterburyju u Connecticutu. Dok je studirala slikarstvo
na San Francisco ,Art Institutu®, pohadala je no¢na predavanja u fotografiji, a
1970. pocela je raditi za ¢asopis ,Rolling Stone“. Godine 1973. postala je
glavna fotografkinja ,Rolling Stonea“. Do trenutka kada je napustila ¢asopis,
deset godina kasnije, snimila je 142 naslovnice. Godine 1983. pridruZila se
Casopisu ,Vanity Fair“, a 1998. godine pocela je raditi i za ¢asopis ,Vogue*.
Pored uredniStva Casopisa, Leibovitz je stvorila utjecajne reklamne kampanje za

,<American Express®i ,Gap"“.

Annie Leibovitz je bila posljednja osoba koja je profesionalno fotografirala John

Lennona zbog toga $to je ubijen te nodéi (Slika 13). [4]

Slika 13. John Lennon i njegova supruga Yoko, naslovnica ,Rolling Stonea“ 1980.

https://yakymour.wordpress.com/tag/john-lennon/
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2.2. Modna fotografija danas

21. stoljeCe vec su obiljezile tri stvari, a to su bombaski napad 11. rujna,
globalizacija i osiromasenije treceg svijeta, te gospodarski pad od 2007. do
2010. godine. Cini se da je to utjecalo na modu na brojne nacine. Eti¢ka praksa
trgovanja i zelena politika oblikuju politiku kupnje. Gotova odje¢a sada se
uglavnom proizvodi u Kini. Bijeg od stvarnosti i ublazavanje financijskih i
politiCkih neizvjesnosti potaknulo je ozivljavanje nadrealistiCke i kicaste modne
fotografije, kao i nastavak koriStenja poznatih osoba i dugogodisnjih modela.
Rastuce nezadovoljstvo utvrdenim vrijednostima u svijetu Stednje Sirom svijeta
nastavlja poticati uporabu kontroverznih elemenata u stvaranju modnih
fotografija, iako ne u opsegu Oliviero Toscanijevih konfrontacijskih fotografija za
,Benetton“ 80-ih godina proslog stolje¢a. Smréu Herba Rittsa, Richarda
Avedona, Helmuta Newtona, Francesca Scavullo i Irvinga Penna, danasnji
vodeci modni fotografi su Patrick Demarchelier, Steven Meisel, Mario Testino,
Peter Lindbergh, Oliviero Toscani, Annie Leibovitz, Nick Knight i David
LaChapelle. Na modnoj fotografskoj sceni su se takoder pojavili mladi modni
fotografi poput Christophe Kutner, Glen Luchford, Craig McDean i Javier
Vallhonrat. lako su Kate Moss, Naomi Campbell, Gisele Bundchen i drugi od
ranije poznati modeli i dalje vodeci na tom polju, novi narastaj profesionalnih
modnih modela 21. stolje¢a, prema navodu ameri¢kog ,Voguea“ u svibnju 2007.
godine, ukljuCuje: Agyness Deyn, Lily Donaldson, Chanel Iman, Doutzen Kroes,
Sasha Pivovarova, Hilary Rhoda, Coco Rocha, Jessica Stam, Caroline Trentini i
Raquel Zimmermann. U meduvremenu, vodeéi modni ¢asopisi (osim ,Vogue® i
,2Harper's Bazaar“) uklju€uju ,Elle* (najprodavaniji modni magazin na svijetu),
,Cosmopolitan®, ,Seventeen®, ,W*, ,Vanity Fair‘, ,GQ", ,Grazia“, ,Marie Claire®,

kao i ,Dazed and Confused®, te ,Sleaze Nation®. [2]
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2.2.1. Poznati modni fotografi danas te njihov rad

2.2.1.1. Kristian Schuller

Kristian Schuller (roden 24. prosinca 1970. u Halchiu, Rumunjska) je njemacki
modni fotograf. Schuller je poznat po svojim velikim i nadmoénim Sarenim
fotografijama. Schuller je radio s mnogim modnim ¢asopisima i dizajnerima te
ima vrlo jedinstven ukus u fotografiji. Njegov otac bio je kazaliSni dramaturg i
redatelj, a Kristianova fotografija moze se nadahnuti njegovim iskustvima

tijekom djetinjstva. [5]

Slika 14. Fotografija Kristiana Schullera za ,Chanel*

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/

Slika 15. Fotografija Kristiana Schullera

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.2. Mert & Marcus

Mert i Marcus je radno ime dvojice modnih fotografa (Mert Alas | Marcus
Piggott) koji rade u suradnji. Mert (iz Turske) i Marcus (iz Velike Britanije)
rodeni su 1971. godine, te su jedan od premijernih fotografskih dvojaca na
svijetu. Mert i Marcus sastali su se u Engleskoj 1994. godine nakon Sto su radili
kratko vrijeme u razliitim podrucjima, Mert u klasi¢noj glazbi i Marcus u
grafickom dizajnu. Marcus je bio pomocni fotograf a Mert je bio modni foto
model. Radedéi zajedno u fotografiji, odlucili su stvoriti tim. Kad su svoje prve
fotografije pokazivali londonskom modnom ¢asopisu ,Dazed and Confused®,
odmah su napravili naslovnicu. Tim je od tada radio za takve Casopise kao $to
su americki ,Vogue®, pariski ,Vogue®, talijanski ,Vogue®, ,Interview®, ,The Love*,
W Pop“, ,Numéro“i ,Arena Homme Plus®. Neki od njihovih glavnih klijenata
su modne etikete ,Dior*, ,Louis Vuitton“, ,Missoni®, ,Giorgio Armani“, ,Roberto
Cavalli“, ,Fendi“, ,Kenzo® i ,Miu Miu“. Dvojac je takoder stvorio fotografije za

parfemske kuce ,Gucci, ,Yves St Laurent®, ,Givenchy“ i ,Lancome®. [5]

Slika 16. Fotografija dvojca Mert & Marcus

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.3. Nick Knight

Nick Knight roden je 1958. godine, britanski je modni i dokumentarni fotograf.
Osvojio je nagrade za svoje editorijale za ¢asopise ,Vogue®, ,W*, ,Dazed &
Confused®, ,i-DY, ,Another®, ,The Face®, ,BLITZ", ,Arena Homme Plus® i
,Visionaire“, kao i za modne i reklamne projekte kao $to je 2004. godine izdanje
LPirelli“ kalendara. Knightov je rad izloZen u ,Victoria & Albert® muzeju, ,Saatchi®

galeriji, ,Photographers™ galeriji i ,Hayward® galeriji. [5]

Slika 17. Nick Knight — Lady Gaga za ¢asopis ,Vanity fair“ 2010.

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.4. Giampaolo Sgura

Giampaulo Sgura roden je 1975. u Italiji. Medunarodno je poznat po svojoj
modnoj fotografiji u koju su uvijek ubrizgane romantika i strast njegove
domovine. Nakon $to je studirao arhitekturu u Milanu, gdje sada zivi, Giampaolo
je promijenio puteve karijere prema fotografiji. Francuski ,Vogue“ opisuje
fotografsku viziju Zena kao ravnotezu izmedu senzualnosti, Zenstvenosti i
glamura. Sgura je snimio kampanje za modne kuce ,Dolce & Gabbana®,
,Roberto Cavalli“, ,Moschino“, ,Emporio Armani“i La Perla“. Radio je i
editorijale za talijanski ,Vogue®, ,Italian Glamour®, ,GQ", portugalski ,Vogue®,

japanski ,Vogue“ i francuski ,Vogue®. [5]

Slikal8. Giampaolo Sgura — ,Dolce & Gabbana“ modna kampanja

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/

Slika 19. Giampaolo Sgura — Kendra Spears za Spanjolski ,Vogue®, velja¢a 2014.

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.5. Mario Sorrenti

Sorrenti je roden u Napulju u ltaliji 1971. godine i preselio se u New York kada
je imao deset godina, gdje jos$ uvijek zivi. Mario Sorrenti pojavio se na modnoj
sceni u 1990-ima, uglavnhom zbog svog seksualno orijentiranog urednickog
rada, objavljenog u ameri¢kom i talijanskom ¢asopisu ,Vogue“ i asopisu
,Harper's Bazaar®. Fotograf je rekao u intervjuu da je prilicno otvoren, ne boji se
ljudi, ne boji se zena, ne boji se seksa i seksualnosti. To je dio njega, i to se vidi
na njegovim fotografijama. Kao da u trenutku fotografiranja nije ¢ovjek i nije
Zena. Ako vidi trenutak koji mu izgleda istinit, to se €ini iskreno, bilo zensko ili
musko, i to je dio njega. Sorrenti je cementirao svoje mjesto na vrhu industrije
tako Sto je snimio Kate Moss, ,Calvin Kleinovu® ikonu ,Obsession® kampanje.
Samo 2012. godine, Sorrenti je snimao za ,Vanity Fair“, ,Vogue Hommes*, ,W*,
,The New York Times*, ,W*, ,Self Service® te francuski, talijanski i japanski
,vogue“. Sorrentijev komercijalni posao jednako je popularan s oglasavaju¢im
klijentima, ukljuc€ujuci ,Chanel®, ,Hugo Boss®, ,Max Mara®“, ,Kenzo“i ,Barneys
New York®. [5]

Slika 20. Fotografija koju je snimio Mario Sorrenti

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.6. Mario Testino

Mario Testino roden je 1954. godine i smatra se jednim od najvaznijih utjecajnih
modnih fotografa ovoga vremena. Peruanski fotograf je svoje fotografije objavio
u Casopisima ,Vogue®, ,W* i ,Vanity Fair“. On je definitivno pridonio uspjehu
vodecih modnih i kozmeti¢kih kuca, stvarajuéi fotografije za marke ,Gucci®,

,Burberry®, ,Versace®, ,Michael Kors®, ,Chanel*, ,Estée Lauder® i ,Lancome®. [5]

Slika 21. Mario Testino — Anja Rubik za francuski ,Vogue®, Travanj 2015.

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/

Slika 22. Fotografija koju je snimio Mario Testino

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.7. Chen Man

Rodena u Pekingu 1980. godine, Chen Man odrasla je nakon kulturne revolucije
I bila je dio generacije kineske politike jednog djeteta. Chen je pohadala
pekinsku srediSnju akademiju likovnih umjetnosti i diplomirala je 2005. godine
grafi¢ki dizajn. U dobi od 23 godine objavljena je njezina vlastito stilizirana
fotografija kao naslovnica kineskog €asopisa ,Vision®“, donosedi joj neposrednu
nadmoc po prvi puta kao studentici. Od tada je snimila naslovnice za kineski
,2Harper's Bazaar“ i ,Vogue®, hong kongski ,Harper's Bazaar“, ,Elle“, ,Muse“i ,i-
D“. Chen Manina fotografija za ,i-D-ov* ,Whatever the Weather" editorijal, za
koji je snimila 12 fotografija, opisana je kao jedna od najkreativnijih,
progresivnih i kompozicijski najljepsih fotografija 2012. godine. Poznata je po
svojoj vjestini u digitalnoj post produkciji, a ona redovito pokazuje svoj rad
diljem svijeta. Predstavila je izloZzbe u Parizu, Moskvi, Tokyu, Londonu i Hong
Kongu, kao i njezinu rodnom gradu Pekingu. Njezini komercijalni klijenti su
L2Adidas®, ,Motorola“, ,Guess” i ,MAC" kozmetika. [5]

PHOTOGRAPHY BY CHEN MW

Slika 23. Chen Man - fotografija za ,Guess*

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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Slika 24. Chen Man - fotografija za ,Guess*”

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/

Slika 25. Chen Man - fotografija za ,Guess*

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.2.1.8. Steven Meisel

Roden 1954. godine, Meisel je ameri¢ki modni fotograf, koji je dobio
popularnost i kritiCku zahvalnost svojim radom u ameri¢kom i talijanskom
Lvogueu“ kao i za njegove fotografije Madonne u njezinoj knjizi ,Seks" iz 1992.
godine. Sada ga smatraju jednim od najuspjesnijih modnih fotografa, redovito
snimajuci za americki i talijanski ,Vogue®, ,Interview" i ,W*. Meisel je izmedu
ostalih snimio i kampanje za ,Versace®, ,Valentino®, ,Dolce & Gabbana®, ,Louis
Vuitton“, ,Balenciaga“ i ,Calvin Klein“. Meisel takoder snima ,Pradine“ kampanje
svake sezone od 2004. godine. U travnju 2008. godine snimao je Madonnu za
Lvanity Fair“, a kasnije u godini je snimio proljetnu kampanju ,Louis Vuitton“ za
2009. godinu. On je blizak prijatelj dizajnerice Anne Sui za koju je takoder

snimao u nekoliko kampanja, iako Sui rijetko koristi reklame za promociju svoje

odjece. [5]

Slika 26. Steven Meisel — Carolyn Murphy za talijanski ,Vogue®, lipanj 2005.

http://www.nickburrett.com/blog/top-10-best-fashion-photographers-in-the-world/
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2.3. Vrste modne fotografije
2.3.1. Editorijal

2.3.1.1. Fashion editorijal

Postoje razne vrste modne fotografije s obzirom na to u koje svrhe se te
fotografije kasnije koriste. Vrsta modne fotografije na koju se najéeS¢e pomisli
kada se Cuje pojam modna fotografija su editorijali. Takve fotografije mogu se
vidjeti u sredinama €asopisa kao modna pri¢a na nekoliko stranica, naj¢esc¢e od
4 do 10 stranica. Svrha editorijala nije direktno prodati proizvod, vec¢ pri€u koja
se temelji na modnim trendovima, kulturama, bojama, sezonama itd. Editorijali
prikazuju zZivotni stil kroz fotografije zgodnih, modno osvijestenih, dotjeranih
modela stavljenih u ulogu ili temu te djeluju unutar te priCe. Takve fotografije ne
prikazuju kako treba izgledati, ve¢ potiCu mastu te nude inspiraciju

promatraCima. (Slika 27) [6]

WICAN GIANNELI

Slika 27. Jesse Maricic - Micah Gianneli za ,Levis*

https://s-media-cache-ak0.pinimg.com/736x/d4/99/cb/d499cbc88lacfce2d66add63919625e2--
fashion-editorial-photography-urban-photography-model.jpg
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2.3.1.2. Beauty editorial

Beauty editorijali su fotografije koje poblize prikazuju lice modela da bi naglasili
Sminku, kosu ili modne detalje poput nakita. (Slika 28) Takve fotografije su
Cesto popracene popisom kozmetikih proizvoda koji su koristeni na modelima.

[6]

Slika 28. Steven Jones - Lauren Frensham za ,Amanda Nash Makeup*

https://s-media-cache-
ak0.pinimg.com/originals/57/a9/82/57a9829ab89e29dd8ab2fedefc5923fd.jpg
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2.3.2. Komercijalna modna fotografija

Komercijalna modna fotografija, koja se ¢esto naziva i kataloSka modna
fotografija, direktno prodaje odjecu, Sminku, modne dodatke, proizvode za
njegu kose, itd. Takve fotografije prikazuju proizvod u cijelosti, te model pozira
na nacin na koji se najjasnije vidi proizvod, sa svrhom poticanja promatraca na

kupnju tog odredenog proizvoda. (Slika 29) [6]

Slika 29. ,Dolce&Gabanna® katalog jesen/zima 2013.

http://www.dolcegabbana.mobi/uploads/deploy/dg/filemanager/cms_dolcegabbana/dg/img/winte

r13/catalogue/woman/sera/dolce-gabbana-fw-2013-collection-women-evening-02.jpg
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2.3.3. High fashion modna fotografija

High fashion modna fotografija koristi modele elitnih proporcija i specific¢nih crta
lica koji nose ekskluzivnu, luksuznu, elegantnu i skupocjenu odjecu najboljih
svjetskih modnih dizajnera. Takve modne kombinacije stvaraju ideje za nove
modne trendove, a Cesto su na granici fantazije s obzirom da su odjevni
predmeti prikazani na nacin na koji se u stvarnosti ne bi mogli nositi. Takve
fotografije osmisljene su sa svrhom da oduzmu dah gledateljima i Cesto se

koriste u modnim Casopisima. (Slika 30) [6]

Slika 30. Bruno Dayan - High Fashion modna fotografija

http://fionatimantti.blogspot.hr/2010/10/inspiration-fashion-photos-by-bruno.htmi
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2.3.4. Sto nije modna fotografija

Modna fotografija naglasava modu u prvom planu, dok je model u drugom
planu. U slu€aju kada je na fotografiji naglasen model a moda ne dolazi do
izrazaja, takva fotografija ne smatra se modnom fotografijom. Takoder, kod
fotografija koje poblize prikazuju lice modela naglasavaju¢i Sminku, kosu ili
modne dodatke, vazno je vrlo jasno naglasiti proizvode. Ukoliko se model istiCe
viSe od proizvoda, takva fotografija smatra se portretom, a ne modnom
fotografijom. (Slika 31) [6]

4 ' ; S ; '.‘ . :
sl P~ o Ak = »‘..“I* |

Slika 31. Portret koji se ne smatra modnom fotografijom

https://designyoutrust.com/wp-content/uploads/2012/08/i1a29.jpg

34



2.4. Ulicna modna fotografija

Uliéna modna fotografija je snimana izvan studija, $to ne mora nuzno znaciti na
ulici. Uliéna modna fotografija podrazumijeva vanjski prostor u koji se smjestaju
modeli, te nudi brojne vizualne mogucénosti, na primjer bezbroj prirodnih

pozadina koje se mogu zanimljivo kombinirati sa izgledom modela.

'l

Slika 32. Jesse Maricic — Micah Gianneli

http://micahgianneli.com/these-boots/

Ulicna modna fotografija je Cesto izazov, ali i zabava otkrivanja raznih lokacija
te uskladivanja prirodnih efekata i modela. Postoje razni savjeti kako modne
fotografije u€initi posebnima i zanimljivima, a neki osnovni su opisani u
nastavku. S obzirom da je svaki fotograf poseban na svoj nacin, najbolji rezultati
dobivaju se improvizacijom i iskustvom, tako da ne treba bas sve savjete slijediti
u stopu, ali dobar savjet uvijek moze pomodi.

Uvijek je dobra ideja isplanirati lokaciju nekoliko dana unaprijed kako bi se
izbjeglo troSenje vremena tijekom dana snimanja. Pametno je hodajuci gradom
promatrati i razmisljati o lokacijama tako da se unaprijed ve¢ dobe ideje za

snimanje. Ako fotograf u glavi ima nekoliko zanimljivih lokacija, moze prije
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snimanja posjetiti neke od njih da bi vidio da li je u tom trenutku mogucée snimati
na tome mjestu. Takoder moze snimiti par fotografija da bi predvidio okvire koje
bi Zelio snimiti sa modelom. Takoder se treba uvijeriti u to da nema ogranicenja
za snimanje, a ukoliko ogranienja postoje da se stignu nabaviti dozvole
unaprijed. [7]

Znakovi tjeskobe, stresa ili nelagodnosti modela uvijek ¢e se negativno odraziti
na finalni proizvod. Izrazi modela jedan su od klju¢nih elemenata modne
fotografije. Stoga je uvijek dobro provesti neko vrijeme sa modelom i razmijeniti
nekoliko rijeCi prije nego Sto se pocne snimati tako da se model tijekom
snimanja osjeca udobnije. Takoder modelu da se osje¢a udobnije moze pomodi
neprestano davanje komplimenata oko njegovih poza i izraza ¢ime ¢e postati
samouvjereniji a samim time i opusteniji. [7]

Za razliku od umjetnog izvora svjetla, kontroliranje intenziteta i smjera prirodnog
izvora svjetlosti nije moguce. Ali to se moze prevladati stavljanjem modela na
takav nacin da se dobije Zeljena koli€ina i smjer svjetla. Najbolji rezultati postizu
se kada se model postavi u takav polozaj da prirodno svjetlo pada ili sa strane
na lice, ili na kosu i ramena s leda stvarajudi velicanstven izgled. Treba
izbjegavati postavljanje modela izravno prema suncu jer ¢e to rezultirati teSkim i
dubokim sjenama, kao i mr§tenjem modela §to definitivno nece lijepo izgledati
na fotografijama, a takoder &e izbiti i prirodnu boju lica. [7]

Cesto prirodno svjetlo nije dovoljno, pa se moze dodati svjetiljka ili reflektor kao
dodatno osvijetljenje. Svi vole gledati dramati¢ne fotografije s tamnom
pozadinom i usmjerenim izvorom svjetla koji se fokusira na model. Uvijek je
sjajna ideja nositi baterijsku svjetiljku ili studijsku svjetiljku na otvoreni nacin
snimanja. Kreativnost se moze izraziti raznim kombinacijama svjetlosti
postavljenim na razne nacine. [7]

Uvijek je dobro nositi neke referentne fotografije dobrih fotografa da bi model
dobio neke ideje za poziranje. Modelima je teSko objasniti na€in na koji moraju
pozirati ukoliko se ne bave time profesionalno, a posebno kada nisu potpuno
opusteni. Takoder, fotograf moze dobiti neke ideje koje ¢e zajedno sa njegovom

improvizacijom na fotografijama ispasti posebno i zanimljivo. [7]
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Snimanje fotografija na razini o€iju nije najzanimljivije rijeSenje za uli¢nu modnu
fotografiju. Uvijek je zabavno pokusati postaviti fotografski aparat pod visokim ili
niskim kutom da bi se dobili neki drugaciji okviri i perspektiva, zadrzavajuci
fokus na oCima. Fotograf se mozZe popeti na neke ljestve ili stepenice, ili spustiti
u zablju perspektivu da bi isprobao razne kutove snimanja. [7]

Kao $to je Shakespeare rekao, oCi su prozor vase duse, zato se uvijek treba
usredotociti na o¢i modela, to¢nije na ono oko koje je blize kameri. Dodatno

osvjetljenje ociju bilo bi pun pogodak. [7]

Slika 33. Jack Waterlot - Vlada Roslyakova za ruski ¢asopis ,Marie Claire“, kolovoz 2015.

http://visualoptimism.blogspot.hr/2015/07/vlada-roslyakova-by-jack-waterlot-for.html
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2.5. Usporedba uli¢ne u odnosu na studijsku modnu fotografiju
2.5.1. Sto je studijska modna fotografija

lako vecina fotografa preferira vanjsko snimanje s obzirom na zanimljive
lokacije i mogucnosti koje one nude, povremeno svi snimaju i fotografije u
studiju. Studijska modna fotografija najceSce se koristi za kataloge kod kojih je
vazno prikazati proizvod u najboljem izdanju, dok je umjetnicka strana manje

vazna u tom slucaju. [8]

Slika 34. Fotografija snimana u studiju

http://www.pantyhoz.net/images/52809999.jpg
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2.5.2. Prednosti uli¢ne u odnosu na studijsku modnu fotografiju

Prednosti ulicne modne fotografije, odnosno snimanja izvan studija su u
najvecoj mjeri bezbroj zanimljivih lokacija koje na fotografijama stvaraju
prirodne Sarene pozadine za modele. JoS jedna prednost kod snimanja izvan
studija je prirodnost, prirodno svjetlo, prirodni vjetar u kosi, spontanost koja se
vrlo teSko moZze dobiti snimanjem u studiju. Fotografije snimljene izvan studija
imaju odredenu umjetniCku notu, te prenose razne prirodne osjecCaje na
promatrace, koje je teze dobiti snimanjem u studiju. Takoder, fotografije
snimljene izvan studija, na zanimljivim lokacijama i sa dobrim modelima, Cesto
nije potrebno digitalno uredivati, kao ni prethodno slagati kompoziciju, dovoljno
je namjestiti model i snimiti fotografiju, dok snimanje u studiju vrlo ¢esto
zahtjeva prethodno slaganje kompozicije, nabavljanje raznih dodatnih rekvizita
ili pak kasnije digitalno uredivanje dodavanjem pozadine itd. [8]

2.5.3. Nedostaci ulicne u odnosu na studijsku modnu fotografiju

Jedan od najvecih nedostataka ulicne u odnosu na studijsku modnu fotografiju
je taj Sto se kod snimanja izvan studija teSko mogu kontrolirati uvjeti. Kod
snimanja u studiju, potpuno se moze kontrolirati svjetlost, uklju€ujuéi intenzitet,
smijer i koli€inu svjetla. Takoder, studiji su opremljeni raznom opremom koja
olakSava snimanje, svaka ideja je izvediva u studiju, dok izvan studija nije bas
uvijek moguce nositi svu potrebnu opremu. Primjerice, ako izvan studija vjetar
puse u suprotnome smjeru od Zeljenoga, potrebno je pomaknuti model ¢ime se
mijenja cijela kompozicija, dok se u studiju koristi ventilator koji se namjesta
prema potrebi. Jedna velika prednost studijske u odnosu na ulichu modnu
fotografiju je upravo u tome $to je, bez obzira na vremenske uvjete ili razne

nepredvidene smetnje, snimanje uvijek moguce prema planu. [8]
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2.6. Digitalno uredivanje fotografija

U digitalnom dobu se od fotografa oekuje da bude upoznat sa digitalnim
uredivanjem fotografija. Mnogi smatraju da ,Photoshop® unistava fotografiju, o
¢emu bi se dalo raspravljati da li je to to€no ili krivo. Medutim, ,Photoshop® kao
alat nece unistiti fotografiju, ve¢ ju moze unistiti samo osoba ukoliko pretjera sa
uredivanjem fotografija ili ih uredi na krivi nacin. Rijetke su fotografije danas
koje nisu digitalno uredivane prije objavljivanja, a umjereno i svjesno koristenje
,Photoshopa“ moze uvelike poboljSati dojam fotografije a da ona i dalje ostane
prirodna.

Digitalno uredivanje ulicnih modnih fotografija takoder je Cesto, s obzirom da na
ulici fotograf nije u mogucnosti potpuno kontrolirati sve uvjete. Ponekad svjetlo
nije onakvo kakvo je fotograf Zelio Sto se kasnije moze digitalno promijeniti, ili
se ba$ u krivom trenutku neplanirano nasao dodatni objekt na fotografiji koji je u
,Photoshopu“ lako moguce ukloniti, a Cesto se ulicne modne fotografije ureduju
s namjerom da izgledaju dinami¢nije pove¢anjem kontrasta ili modulacijom
boja, te naravno, jo§ mnogo toga.

Postoje mnogi nacini uredivanja fotografija kako u ,Photoshopu® tako i u drugim
programima, a svaki fotograf ima svoj nacin digitalnog uredivanja fotografija
prilagoden svojim Zeljama i potrebama, s obzirom na kakav nacin zeli istaknuti
svoje fotografije Sto se postiZze visegodisnjim iskustvom rada u tome podrucju.
U nastavku slijedi nekoliko savjeta za digitalno uredivanje fotografija iz iskustva
viSe fotografa koji se godinama bave snimanjem, a samim time i digitalnim

uredivanjem fotografija.
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2.6.1. Osvijetljavanje fotografija

Slijedi detaljan savjet fotografkinje Tigz Rice koja opisuje osvjetljavanje
fotografije u ,Photoshopu” kako bi fotografija dobila ljetni dojam pomocu
mjeSavine suptilnih prilagodbi koje utjeCu na ukupni ton fotografije te preciznog
uredivanja odredenih podrucja i boja za dobivanje pravog osjecaja topline.
Krajnji rezultat je lijep, zivahan i ima pravi osjec¢aj savrSenog ljetnog dana bez

neodgovarajuce slabo osvijetljene fotografije. [9]

Slika 35

http://www.digitalartsonline.co.uk/tutorials/photoshop/how-brighten-photo-in-photoshop/
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Otvara se fotografija u programu ,Photoshop® i duplicira se background image
pritiskom tipki ,Ctrl+J“ dva puta. Preimenuju se slojevi, u ovom slu€aju prvi sloj
preimenuje se u Vibrance a drugi u Lighten. Sa ozna¢enim Lighten slojem
odabere se Screen u Blending Mode meniju, $to ¢e vjerojatno biti presvijetlo od
poCetka pa se zbog toga Opacity layera stavi na 40%. Napravi se Layer Mask
na Lighten sloju pritiskom ikone na vrhu Layers prozora. Sa mekim crnim kistom
prelazi se preko dijelova fotografije koji nece biti posvijetljeni.

Pritiskom na Vibrance layer selektira se Soft Light u Blending Modes meniju te
se takoder Opacity postavi na 40%. Napravi se Layer Mask kao i u drugom
sloju ukoliko se odredene dijelove Zeli saCuvati od uredivanja.

Sljedeci korak je prebaciti sve slojeve u Smart Object Sto je potrebno da bi se
dodali dodatni efekti na cijelu fotografiju, Sto se kasnije dvostrukim klikom moze
opet razdvojiti. Za prebacivanje u Smart Object potrebno je selektirati sve
slojeve te desnim klikom odabrati Convert to Smart Object. Kada je vidljiv samo
jedan sloj, moze se dodati Camera Raw Filter (Filter > Camera Raw Filter). U
prozoru koji se otvori moguce je prilagoditi ekspoziciju, balans bijele boje, a
moguce je i dodati efekt pritiskom na Effects ispod histograma. Moguce je

ugrijati fotografiju koriStenjem Split Toning, takoder ispod histograma. [9]
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2.6.2. Selektiranje samo tonova koze

Ponekad je potrebno selektirati samo tonove koze na modelu za promjenu tona,
svjetline ili teksture, a ne primijeniti promjenu na cijeloj fotografiji.

Fotografkinja Tigz Rice objasnjava kako to uciniti u samo nekoliko koraka.
Otvori se Zeljena fotografija u ,Photoshopu” te se pritiskom na Select > Color
Range otvara prozor u kojemu se odabere Skin Tones. To automatski odabire
sve tonove sli¢ne tonovima koze. Pritiskom na Selection Preview na dnu
prozora odabire se Grayscale $to to¢nije prikazuje podrucja koja su selektirana
kao tonovi koze. PodeSava se Fuzziness do te mjere kada je sva koza

selektirana, pri Cemu je potrebno paziti da samo koza bude selektirana. [10]

Slika 36

http://www.digitalartsonline.co.uk/tutorials/photoshop/how-select-skin-tones-in-photoshop/#5

Vracanjem u prvobitni prozor, u Adjustment panelu odabire se Adjustment layer
kako bi se promjena automatski prilagodila, ili se moze napraviti Layer Mask te

uredivati ru¢no. [10]
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2.6.3. Apliciranje foto filtera koriStenjem gradient maps u ,Photoshopu*

,Photoshop* nudi brojne sjajne mogucénosti uredivanja fotografija, iako su neke
teze za pronaci od ostalih. Jedna od takvih sakrivenih ali vrlo korisnih

mogucnosti je ova.

Slika 37

http://www.digitalartsonline.co.uk/tutorials/photoshop/apply-photo-filter-effects-using-gradient-

maps-in-photoshop/#1

Otvori se fotografija u ,Photoshopu® te se u Adjustment panel odabere Add New
Gradient Map. Ukoliko panel nije otvoren, moZe se otvoriti na na¢in Window >
Adjustments. Klikom na Gradient Map, automatski ¢e se primijeniti gradijent na
fotografiju, najceSce crno bijeli. Klikom na drop-down gradient meni pokraj
gradient bara, moze se pristupiti ostalim gradijentima spremljenima u
,Photoshopu“. Za dodavanje odredenog gradijenta, klikom na ikonu kotaca u
Gradient Map prozoru i skrolanjem dolje do Photographic Toning. Odabirom
Append dodaju se u vec spremljene gradijente. U novo dodanim gradijentima
mogu se naci razni efekti poput sepie i slicno. U listi gradijenata moze se
pronaci split tones koji nudi komplementarne sheme boja. U ovom primjeru je
dodan Sepia Selenium mix koji daje toplinu i kontrast originalnoj fotografiji. Ono
$to je najbolje je da se svaki gradijent moZze prilagodavati. Pritiskom na Sarenu
ikonu u Gradient Map prozoru, otvara se prozor gdje se moze podesiti sve

prema zelji. [11]
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2.6.4. ,Photoshop” alat Dehaze za vanjske fotografije

Dehaze je alat koji je uveden tek u ,Photoshop 2015 CC*, a koristi se za
vracanje boje mutnim fotografijama snimljenima na otvorenome. Takoder je
savrSen alat za fotografije snimljene u zlathom satu (uvecer kada sunce pada).
U nastavku slijedi joS jedan savjet za uredenje fotografija fotografkinje Tigz

Rice.

Slika 38

http://www.digitalartsonline.co.uk/tutorials/photoshop/use-photoshop-cc-2015s-new-dehaze-

and-grain-on-blur-to-retouch-a-photo/

Otvori se Zeljena fotografija u ,Photoshopu® te se pretvori u Smart Object (desni
klik na layer > Convert to Smart Object). Nakon toga se otvori Camera Raw
prozor (Filter > Camera Raw Filter) gdje se mogu promijeniti postavke
ekspozicije, CistoCe i bijelog balansa ukoliko je to potrebno. Zadrzavajuci se u
Camera Raw prozoru, klikom na Effects tab, pronalazi se Dehaze slajder koji se
pomice u desno ukoliko je potrebno vratiti boju koja je izgubljena tijekom
snimanja u sunce. Nakon zadovoljavaju¢eg podeSavanja vraca se na pocetni
prozor. Sljedece slijedi dodavanje Blura (Filter > Blur Gallery > Iris Blur). Klikom
miSa stvara se krug kojim se oznaCava centar oko kojeg ¢e nastati blur. Klikom
na rub kruga mogu se mijenjati parametri kruga. U krugu se nalaze 4 bijele
toCke koje se mogu pomicati $to odreduje prelazak ostrine u blur, $to su tocke
postavljene dalje od centra, to je mekaniji prijelaz. Nakon postavljanja, u

gornjem desnom kutu moze se mijenjati koli¢ina blura prema Zelji. [12]
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2.6.5. Smanjenje zrnatosti fotografije

Cesto se dogada da fotografija ispadne zrnata, najéesée ako je fotografirana
nocu, u slabo osvjetljenim uvjetima, sa velikom ISO osjetljivoScu.

Noise Reduction Filter je odliCan za smanjenje zrnatosti fotografija jer nudi
kontrolu nad luminacijom i bojom, a takoder se zrnatost moze smanjivati po

kanalima. [13]

Slika 39

http://www.exposureguide.com/image-noise-reduction.htm

46



Najprije treba Background Layer prebaciti u Smart Object kako bi se saCuvala
sva svojstva originalne fotografije. Na taj naCin se ne smanjuje kvaliteta ukoliko
se fotografija ureduje putem Edit > Transform. Odabirom Filter > Noise >
Reduce Noise otvara se prozor u kojemu se nalazi prikaz fotografije na kojemu
se moze oznaciti koje dijelove se zeli promijeniti te se sa desne strane odabire
koli¢ina smanjenja zrnatosti. Povecanjem Preserve Details gubi se manje
detalja, no ponekad nije moguce ne izgubiti detalje ako je fotografija vrlo zrnata.
Pomicanjem Reduce Color Noise i Sharpen Details slajdera moze se
eksperimentirati i dobiti odgovarajuée rezultate. Smanjenje zrnatosti uklanja
sitne mrlje nastale od toga na fotografiji, no ukoliko se pretjera te ode ispod
50% onda je fotografija previSe zanemarena. U slu¢aju kada se bas mora otici
ispod 50%, onda je dobro dodati sloj Hue/Saturation za podeSavanje zasiéenja.
[13]

€Ot
( Cancel )
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@w O Advanced

Settings: | Default Wl ala
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Preserve Detalls: [2¢ % 4m

Reduce Color Noise: |16 x 4m

Sharpen Details: (13 |x 4
R

Remove JPEC Artifact

Slika 40

http://www.exposureguide.com/image-noise-reduction.htm
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2.6.6. ,Photoshop” alati Dodge i Burn

Dodge alat, kao u tradicionalnoj tamnoj sobi, u€init ¢e podrucja fotografije
svjetlijima. Burn alat u€init ¢e podrucja fotografije tamnijima. Ta dva podrucja
kontrole omoguciti ¢e stvaranje bogatijih i o€aravajucih atmosfera na
fotografijama. Ti alati posebno dolaze do izrazaja kod crno bijelih fotografija.

Slika 41

http://www.exposureguide.com/dodging-and-burning.htm

Nakon otvaranja fotografije u ,Photoshopu®, selektira se Dodge alat te je
potrebno u opcijama provijeriti da li je dodge alat fokusiran na sjene, polutonove
ili svjetline. Najefektivnije je ako se radi sa polutonovima. Nakon toga potrebno
je postaviti Exposure Sto odreduje jacinu efekta. Najbolji efekt postiZze se sa

postavljenih 20% jer sve iznad toga moZe izgledati neprirodno i pretjerano.
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Odabir kista je vazan jer je potrebno odabrati kist dovoljno velik koji pokriva
Zeljeno podrucje, ali dovoljno mali da bude neprimjetan. Pomicanjem Dodge
alata preko podrucja fotografija da bi ih posvijetlili bez utjecaja na cjelokupnu
fotografiju.

Burn alat radi isto kao i Dodge alat, ali umjesto posvijetljenja, on zatamnjuje
podrucja. Takoder u opcijama postoji moguc¢nost odabira sjena, polutonova i
svjetline. NajCeSc¢e se odabiru sjene s obzirom da se Cesto Zeli naglasiti
kontrast. Nakon toga se kistom prelazi preko podrucja koja je potrebno
potamniti. Na kraju se mogu dodatno posvijetliti svijetli tonovi koriStenjem

Dodge alata i odabirom opcije Highlights. [14]
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3. EKSPERIMENTALNI DIO

Tijekom pisanja rada napravljeno je istrazivanje o tome koliko su ljudi danas
upoznati sa modnom fotografijom, te koliko modnu fotografiju smatraju vaznom
u danasnjem svijetu. IstraZivanje je provedeno kao anketa, sa kratkim vrlo
jasnim pitanjima i ponudenim odgovorima. Cilj je ispitati ispitanike razliCite
Zivotne dobi, razliCitog spola, obrazovanja te razliCitog drustvenog i poslovnog
statusa, s obzirom da je cilj istrazivanja usporediti rezultate promatrajuci upravo

te parametre.

Prije istraZivanja postavljene su 4 hipoteze:

1. Ljudi mlade zZivotne dobi su upoznati te smatraju modnu fotografiju
vaznijom nego ljudi starije zZivotne dobi.

2. Zene su upoznate te smatraju modnu fotografiju vaznom u veéoj mjeri
nego muskarci.

3. Ljudi veceg drustvenog statusa su upoznati te smatraju modnu fotografiju
vaznijom nego ljudi manjeg drustvenog statusa.

4. Ljudi veCeg obrazovanja ili poslovnog statusa su upoznati te smatraju
modnu fotografiju vaznijom nego ljudi manjeg obrazovanja ili poslovnog

statusa.

Dobiveni rezultati istrazivanja odgovaraju na postavljene hipoteze, od ¢ega su
dvije hipoteze potvrdene, jedna hipoteza nije potvrdena, a jedna hipoteza je

djelomi¢no potvrdena.

Prva hipoteza usporeduje rezultate ankete s obzirom na dob ispitanika.
Rezultati su vrlo mjeSoviti te pokazuju da su ljudi Zivotne dobi od 20 do 25
godina upoznati sa modnom fotografijom u najvec¢oj mjeri, nakon toga su ljudi
Zivotne dobi od 30 do 35 godina, slijede ljudi mladi od 20 godina te nakon njih
ljudi Zivotne dobi od 25 do 30 godina, dok su ljudi stariji od 40 godina najmanje

upoznati sa modnom fotografijom. Takoder na osnovu ove hipoteze, ispitano je
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u kojoj mjeri ljudi razli€ite Zivotne dobi smatraju modnu fotografiju vaznom u
danasnjem svijetu. Rezultati pokazuju da ljudi mladi od 25 godina, kao i oni
stariji od 40 godina smatraju modnu fotografiju vaznom u vecoj mjeri nego ljudi
srednjih godina. Time je zadana hipoteza opovrgnuta te slijedi zakljuCak da
upoznatost ljudi sa modnom fotografijom ne ovisi o njihovoj Zivotnoj dobi, kao ni

misljenje o njenoj vaznosti, vec¢ ovisi samo o njihovim interesima u zivotu.

1 2 3 4 5 ‘ <20 GODINA
KOLIKO STE UPOZNATI S m@ @
MODNOM FOTOGRAFIJOM ‘ 20-25 GODINA
. 25-30 GODINA
KOLIKO MODNU 1 2 3 4 5
FOTOGRAFIJU SMATRATE ns Yoo as . 30-35 GODINA
VAZNOM U DANASNJEM AW
SVUETU Y& ‘ >35 GODINA

Slika 42. Prikaz rezultata s obzirom na dob ispitanika

Na osnovu druge hipoteze ispitano je da li su Zene upoznate sa modnom
fotografijom u vecoj mjeri nego muskarci, te smatraju li je vaznom u danasnjem
svijetu u vecoj mjeri od muskaraca. lako je u istrazivanju postavljeno direktno
pitanje koliko ljudi smatraju da su upoznati sa modnom fotografijom, istraZivanje
je postavljeno i na takav nacin da je ispitanicima dati kratki zadatak u kojem od
prikazanih 7 fotografija moraju odabrati one koje oni smatraju modnim
fotografijama. Zadatak je napravljen sa svrhom dobivanja tocnijih rezultata
ankete, s obzirom da ljudi vrlo ¢esto nemaju pravi dojam o tome koliko su
upoznati sa ne€ime. Od ponudenih 7 fotografija, sve su bile modne fotografije,
ali razliCite vrste poput kataloSke modne fotografije, uli€ne modne fotografije,
fotografije koja naglasava nakit itd. Zene su imale viSe to¢nih odgovora nego
muskarci ¢ime je potvrdena hipoteza da su Zene u vecoj mjeri upoznate s

modnom fotografijom nego muskarci. Takoder na postavljeno pitanje koliko
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modnu fotografiju smatraju vaznom u danasnjem svijetu, Zzene su odgovorile da

ju smatraju vaznom u vecoj mjeri nego muskarci.

1 2 3 4 5
KOLIKO STE UPOZNATI S
MODNOM FOTOGRAFIJOM
‘ ZENE
KOLIKO MODNU 1 2 3 4 5 ‘ MUSKARCI
FOTOGRAFIJU SMATRATE
VAZNOM U DANASNJEM

SVIJETU

Slika 43. Prikaz rezultata s obzirom na spol ispitanika

Treéa hipoteza da su ljudi veceg drustvenog statusa upoznati te smatraju
modnu fotografiju vaznijom nego ljudi manjeg drustvenog statusa je potvrdena
usporedbom drustvenih navika ispitanika sa njihovim odgovorima o upoznatosti

sa modnom fotografijom kao i sa njihovim misljenjem o njenoj vaznosti.

1 2 3 r 5

KOLIKO STE UPOZNATI S

MODNOM FOTOGRAFIJOM @ e

‘ VECI DRUSTVENI STATUS
KOLIKO MODNU L 2 : 4 2 . MANJI DRUSTVENI STATUS

FOTOGRAFIJU SMATRATE

VAZNOM U DANASNJEM @

SVIJETU

Slika 44. Prikaz rezultata s obzirom na drustveni status ispitanika

Cetvrta hipoteza usporeduje rezultate istraZivanja s obzirom na razinu
obrazovanja i poslovni status ljudi. Rezultati koji se odnose na obrazovanje

pokazuju da ljudi sa vrlo malom razinom obrazovanja, to€nije oni sa zavrSenom
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osnovnom Skolom, kao i ljudi sa velikom razinom obrazovanja, to¢nije sa
zavrSenim fakultetom, su upoznati sa modnom fotografijom te ju smatraju
vaznom u vecoj mjeri nego ljudi srednje razine obrazovanja, toCnije sa
zavrSenom srednjom Skolom. Takoder, odgovori koji se odnose na poslovni
status ispitanika, pokazuju da su ljudi sa slabijim poslovnim statusom, od kojih
vecina nezaposlenih, u ve¢oj mjeri upoznati sa modnom fotografijom te ju
smatraju vaznijom od ljudi ve€eg poslovnog statusa. Time je hipoteza da su
ljudi veCeg obrazovanja ili poslovnog statusa upoznati te smatraju modnu
fotografiju vaznijom nego ljudi manjeg obrazovanja ili poslovnog statusa
djelomi¢no potvrdena, $to dovodi do zaklju€ka da su ljudi ve¢eg poslovnog
statusa fokusirani na posao pa nemaju dovoljno vremena za svoje druge

interese kao $to to imaju nezaposleni ljudi, Skolarci, studenti ili umirovljenici.

2 3 4 5
KOLIKO STE UPOZNATI S .
MODNOM FOTOGRAFIJOM ° w OSNOVNA SKOLA

. SREDNJA SKOLA
KOLIKO MODNU 1 2

3 4 5
FOTOGRAFIJU SMATRATE
VAZNOM U DANASNJEM @ @ ‘ FAKULTET
SVIJETU

Slika 45. Prikaz rezultata s obzirom na obrazovanje ispitanika

1 2 3 4 5
KOLIKO STE UPOZNATI S
MODNOM FOTOGRAFIJOM
. VECI POSLOVNI STATUS
KOLIKO MODNU 1 2 3 4 5 ‘ MANJI POSLOVNI STATUS
FOTOGRAFIJU SMATRATE
VAZNOM U DANASNJEM W

SVIJETU

Slika 46. Prikaz rezultata s obzirom na poslovni status ispitanika
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4. PRAKTICNI DIO

Da bi se dodatno pokazalo znanje i razumijevanje odabrane teme, tijekom
pisanja rada napravljen je i praktic¢ni dio rada koji ukljuuje autorske modne
fotografije snimljene izvan studija na raznim lokacijama. Prakti¢ni dio rada
snimljen je uz pomo¢ nekoliko prijatelja koji su posluzili kao modeli, a to su
Martina HIiS¢, Sara Zadravec, Stela Zadravec, Petra Sokac i Denis Novak.

Slika 47. Fotografija: Mirela Magek, model: Petra Sokaé
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Slika 48. Fotografija: Mirela Macek, model: Sara Zadravec
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Slika 49. Fotografija: Mirela Macek, model: Stela Zadravec
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Slika 50. Fotografija: Mirela Macek, model: Petra Sokac
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Slika 51. Fotografija: Mirela Macek, model: Denis Novak
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Slika 52. Fotografija: Mirela Magek, model: Martina HIi5¢

Slika 53. Fotografija: Mirela Macek, model: Sara Zadravec
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Slika 54. Fotografija
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Slika 55. Fotografija: Mirela Magek, model: Sara Zadravec
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Slika 56. Fotografija: Mirela Magek, model: Denis Novak
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Slika 57. Fotografija: Mirela Ma&ek, model: Stela Zadravec
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Slika 58. Fotografija: Mirela Macek, model: Sara Zadravec
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Slika 59. Fotografija: Mirela Macek, model: Petra Sokac¢
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Slika 60. Fotografija: Mirela Macek, model: Denis Novak
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Slika 61. Fotografija: Mirela Macek, model: Stela Zadravec
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Slika 62
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Slika 63. Fotografija: Mirela Macek, model: Sara Zadravec
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5. ZAKLJUCAK

Modna fotografija je od samih pocCetaka u 18. stoljeCu izazivala mnogo paznje
posvecene od strane publike te je sve vecim interesom javnosti do danas
postala jedna od najpopularnijih poslovnih aktivnosti. Napretkom tehnologije,
mogucnosti snimanja fotografskim aparatima postale su mnogobrojne. Razvile
su se mnoge vrste modne fotografije te mnogi nacini snimanja modnih
fotografija. Modne fotografije uvijek su zanimljive s obzirom da se modni
trendovi razvijaju i mijenjaju velikom brzinom, pa su stoga modne fotografije
uvijek pune novosti iz modnog svijeta. Svaki fotograf ima svoj individualan stil
snimanja $to fotografijama daje individualnost, a u popularizaciji modnih
fotografija uvelike su pomogli razni digitalni mediji. Moguénosti digitalnog
uredivanja fotografija takoder su mnogobrojne, te postaju sve vecée daljnjim
razvijanjem tehnologije. Sigurno je da ¢e se modna fotografija nastaviti razvijati i
dalje u buduénosti, te da ¢e dobiti sve vie sljedbenika porastom modne

industrije i sve vecim interesom publike za modu i modne trendove.
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